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1 Introduction
The Escenic Widget Framework is an add-on product for the Escenic Content Engine that greatly
simplifies the process of designing publications. Without the Widget Framework, publication design
requires considerable HTML and JSP programming skills. With the Widget Framework, publications
can be designed using a drag-and-drop interface in Escenic Content Studio (the Escenic content
editor).
This manual is a user guide for:
•

Publication designers who want to use the Widget Framework to design Escenic publications

•

Editors and/or journalists who want to be able to "tweak" the layout of Widget Framework
publications

The prerequisites for using this manual are:
•

You have the general design skills needed to work with publication layouts

•

You are familiar with the general structure of Escenic publications

•

You already know how to use Content Studio for editorial purposes

•

You already have some experience of using Web Studio for section management purposes

1.1 What is The Widget Framework?
The Escenic Content Engine is a template-based publishing system, in which content production
is completely separated from layout design. This allows writers and editors to concentrate on the
production of content without needing to think about layout, and allows designers to ensure that
a publication has a consistent, well-designed appearance. Web pages are generated by combining
content items written and edited using Content Studio with templates written in HTML/JSP.
This approach works well, but it has some disadvantages:
•

It requires designers to have HTML and JSP programming skills in addition to design skills

•

It makes publication design a relatively slow and error-prone process, with the result that:
•

Publications cannot easily be redesigned for special occasions

•

The production of ad-hoc extra publications is difficult and in general, too costly

The Widget Framework solves this problem by enabling publication designers to assemble templates
from a library of predefined template fragments called widgets. In this way it is possible to build
a complete set of templates for a publication in a fraction of the time it would take to write, test
and debug templates by hand. A collection of templates that defines the look and feel of an entire
publication is called a blueprint.

1.1.1

About Blueprints

A blueprint, as its name suggests, is a design for one or more publications. A blueprint is, in fact,
itself a publication, but unlike an ordinary publication, it contains templates and widgets instead of
ordinary sections and content items. A blueprint is basically created in the same way as an ordinary
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publication, using the escenic-admin web application, but must have its Publication type set to
configuration (see New publications.
All Widget Framework publications are based on a blueprint, and you can easily change the look
and feel of a publication by changing the blueprint on which it is based. The blueprint on which a
publication is based is defined by a parameter in its feature resource (blueprint.active). This
means you can completely change the appearance of a publication by redefining this parameter (see
section 7.5).
A single blueprint can be shared by several publications, making it easy to maintain a consistent
appearance across a family of related publications. Sharing a blueprint does not, however, enforce total
conformity – the concept of template overlays (see section 1.1.2.1) makes it possible to differentiate
the members of a publication family in a controlled way.
The following illustration shows a Content Studio section tree containing a blueprint (partly expanded)
plus ordinary publications:

1.1.2

About Templates

In the Widget Framework, the word template is not usually used to refer to the JSP templates created
by web developers, but to Widget Framework templates. A Widget Framework template is a
re-usable page layout composed of widgets. Templates are edited using Content Studio. They are
represented in Content Studio by special sections called template sections, and they are stored in
special publications called blueprints.
If you open a blueprint with Content Studio then you will see that templates differ from publication
sections in the following ways:
•

Name: template names always start with config.

•

Page content: instead of actual content items (teasers and so on), template section pages contains
widgets.

•

The Page options property, which is set to config.

•

They are organized in a tree under a root template called config.
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Here is a template section page opened in a Content Studio section page editor:

All the "content items" on this section page are in fact widgets.
1.1.2.1

Overlays

An overlay is a template that can be overlaid on another template in order to modify its appearance
in some way. Overlays provide a means of adding flexibility to blueprints. Blueprints make it possible
to enforce a common look and feel across a family of related publications. Overlays allow publications
within the family to nevertheless express a unique identity, by differing from the common look and feel
at specific points.
There are two different types of overlays that offer different levels of specialization: inheritance
overlays and selective overlays. For further information, see section 3.8.

Copyright © 2010-2017 Escenic AS

Page 7

Escenic Widget Framework User Guide

1.1.3

About Widgets

A widget is represented in Content Studio by a special kind of content item. If you click on File >
New in Content Studio, then the displayed sub-menu should contain a Widgets option. Selecting it
displays a further sub-menu containing a list of available widget types:

The Widget Framework includes a set of standard widgets for creating page components such as:
•

Breadcrumbs

•

Menus

•

Search tools

•

Teasers

•

Stories

making it possible to meet most requirements "out of the box". If you have special needs that are not
satisfied by the supplied widgets, it is possible to write custom widgets of your own (if you have the
necessary HTML and JSP programming skills). This manual does not, however, cover the design and
creation of custom widgets.
The standard widgets do, however, really satisfy a very wide range of requirements, since they are
all configurable: that is, they have properties which you can use to control their appearance and
behavior. This ensures that using the Widget Framework does not impose a generic, pre-packaged look
and feel on publications - there is still plenty of scope for your creativity.

1.2 How Do I Start?
Now that you have a basic idea of what the Widget Framework is intended to do and how it works, it's
probably best to get started. If the Widget Framework has been installed at your site, then all you need
to do is start up Content Studio and log in. The next three chapters will help you to get started working
with blueprints, templates and widgets.
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2 Blueprints
In the Widget Framework, a blueprint is a special kind of publication. A blueprint differs from an
ordinary publication in the following ways:
•

Its publication type property is set to configuration rather than default.

•

Instead of containing actual content (ordinary section pages and content items), it contains
templates and widgets. The templates and widgets define how content is to be presented in
ordinary publications.

This chapter tells you how to create and edit blueprints.

2.1 Creating a Blueprint
You can create a blueprint in two different ways:
•

From scratch, using the escenic-admin web application

•

If the Snapshot plug-in is installed at your site, then you can use the Snapshot plug-in to create a
new plug-in by copying an existing one.

To create a blueprint from scratch:
1.

Open a browser and start the escenic-admin web application.

2.

Select New publications from the menu on the left.

3.

Create a publication as described in New publications. When you get to the Publication type
option, make sure to select configuration rather than default.

To create a blueprint using the Snapshot plugin, follow the instructions given in the Snapshot
documentation. You can only do this if the Snapshot plug-in is installed at your site.

2.2 Editing a Blueprint
You edit a blueprint in more or less the same way as you edit a publication:
1.

Start Content Studio and log in in the usual way.

2.

Open the Content Studio Sections panel. All the blueprints and publications you have access to
will be listed in the section tree.

If you have access to both blueprints and publications, then you should be able to see which is which –
a blueprint contains no ordinary top-level sections such as Home, International, Sport, and so on,
just a single Config section, which is a container for templates. Open this section to start work on the
templates in a blueprint.
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3 Templates
In the Widget Framework, a template is a special kind of section. A template differs from an ordinary
section in the following ways:
•

It is named according to a special convention that identifies it as a template rather than an ordinary
section.

•

Instead of containing actual content (teasers and so on), it contains widgets. The widgets define
how content is to be presented on section pages and on content pages.

•

It is stored in a blueprint rather than in an ordinary publication.

This chapter will tell you how to create and edit templates. It also contains explanations of how
templates work, and how they are related to ordinary sections and content pages. It is probably a good
idea to read through the whole section and then to try following the instructions in section 3.1.

3.1 Creating a Template
A template is basically created in the same way as an ordinary section, but it must be named correctly
and should be created in the config subtree of a blueprint (not in an ordinary publication). To create
a template:
1.

Open the Content Studio Sections panel and expand the section tree to display the existing
templates in the config tree:
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2.

Select the template you want to be the parent of your new template and right click on it to display
its context menu:

3.

Select Create sub section... from the displayed menu. The new section that will be your
template is opened in an editor:

4.

Enter values for the following properties:
Section name
Give the template a descriptive name such as "Front page template" or "Football page
template".
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Unique section name
The section's unique name must be set according a special naming convention. For details,
see section 3.2.
Relative directory URI
It doesn't really matter what you enter here, but by convention you repeat the Unique
section name, replacing all "." characters with "_".
All the other properties can be left empty or with their default values.
5.

Click on Save & close.

6.

Double-click on your new template in the section to open its section page for editing:

7.

Add the groups and widgets you require to the template.

8.

Click on the Save button at the bottom of the section editor (or the Publish button if it is ready
to use).

3.2 Naming Templates
How you name templates is very important, since it determines how they are used. The following
names must be used:
config
config is the container for all templates. It should not contain any layout objects (groups and
widgets). If you do put any layout widgets in it, they will not be used.
config.default
The default template is used for all pages: section pages, article pages and tag pages. It is, as
its name suggest, the root of the default template tree. You can create other template trees for
special purposes (see section 3.2.1).
config.default.section
The config.default.section template is is used for all section pages. It is a child of the
config.default template.
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config.default.article
The config.default.article template is used for all content pages. It is a child of the
config.default template.
config.default.tag
The config.default.tag template is used for all tag pages. It is a child of the
config.default template.

config.default.section.section-name
There can be many such templates, where section-name is the unique name of a particular
section in the publication. The template will then be used for this particular section. It is a
descendant (child, grandchild etc.) of the config.default.section template.

config.default.article.type.type-name
There can be many such templates, where type-name is the name of one of the publication's
content types. The template will then be used for content items of this particular type. It is a
child of the config.default.article template.

config.default.article.section-name
There can be many such templates, where section-name is the unique name of a particular
section in the publication. The template will then be used for content items belonging to this
particular section. It is a child of the config.default.article template.

config.default.article.section-name.type.type-name
There can be many such templates, where section-name is the unique name of a particular
section in the publication and type-name is the name of one of the publication's content types.
The template will then be used for type-name content items belonging to the section called
section-name. It is a child of the config.default.article template.

config.default.tag.scheme.tag-structure-name
There can be many such templates, where tag-structure-name is the name of a particular tag
structure used in the publication - for example, config.default.tag.scheme.places. The
template will then be used for tag pages belonging to the specified tag structure. It is a child of
the config.default.tag template.
config.default.tag.tag-structure-name.tag-term
There can be many such templates, where tag-structure-name is the name of a particular
tag structure used in the publication, and tag-term is the term of a tag in that structure - for
example, config.default.tag.places.bangladesh. The template will then be used for
that specific tag's tag page. It is a child of the config.default.tag template.
config.default.master.master-template-name
There can be many such templates, each defining a master template. A master template
contains a template fragment that can be re-used in other templates. It is a child of the
config.default template. You can give a master template any name you choose. For more
detailed information about master templates, see section 3.6.
This means that:
•
•

The layout of a section called news will be based on the layouts in the templates config,
config.default.section and config.default.section.news (if it exists).
The layout of a content item belonging to the content type story will be based on
the layouts in the templates config.default, config.default.article and
config.default.article.type.story (if it exists).
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•

•

If there is a template called config.default.article.news.type.story, then
any story content items belonging to the news section will use this template instead of
config.default.article.type.story.
The layout of a tag page for the countries tag bangladesh will be based
on the layouts in the templates config.default, config.default.tag,
config.default.tag.scheme.countries (if it exists) and
config.default.tag.countries.bangladesh (if it exists).

3.2.1

Multiple Template Roots (Content Profiles)

The Widget Framework is delivered with a single template root or content profile called default.
It is, however, possible to create additional template roots, each with their own hierarchy of templates.
In this way you can define different layouts for different purposes. You might, for example, add a
newsletter template root, with a hierarchy of templates designed to provide a newsletter layout, or
an inline root containing templates for in-line loading (see section 3.2.1.1).
For information about how to configure the Widget Framework to support and make use of multiple
template roots, see Content Profiles in the Escenic Widget Framework Developer Guide.
3.2.1.1

The Inline Template Root

The template root name inline is reserved for a special purpose. It can be used to provide a special
set of article templates that are used for in-line loading of content. In-line loading means that when
the user clicks on a teaser link on a section page, the content item is loaded directly into the current
page instead of being displayed on a new page.
This on-line loading behavior can be configured in the Link settings of Teaser and Teaser view
widgets. When a content item is loaded in this way, its layout is determined by the content of the
appropriate config.inline.article template rather than a config.default.article
template.
Inline templates are only ever selected for content items, so there is no point including section
templates under the inline template root.
Inline templates are selected in exactly the same way as default templates. If, for example you want
a special inline template to be used for your Story content items, then you can achieve this by
defining the following inline template hierarchy:
config
config.inline
config.inline.article
config.inline.article.type.story
3.2.1.2

The OEmbed Template Root

The template root name oembed is reserved for a special purpose. If your installation includes Live
Center (a Content Engine plug-in for editing and managing live blogs), then you can use the oembed
root to hold a special set of article templates for rendering content items that have been embedded
in Live Center event entries. For general information about displaying Live Center event entries, see
section 7.20. Note that oembed templates will only work with Live Center version 1.4 or later.
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Live Center allows live bloggers to embed Escenic content items in their blog posts (or event entries).
When a Live Entries view is used to render event entries, any embedded content items are rendered
using config.oembed.article templates rather than config.default.article templates.
You should only include article templates under the oembed template root: if you include section
templates they will not be used.
The root group of all config.oembed.article templates must be an OEmbed config group. This
group is a simplified version of the Config group that forms the root of config.default.article
templates.
OEmbed templates are selected in exactly the same way as default templates. If, for example, you want
all your content items except Picture to be rendered by the same template, then you can achieve this
with the following oembed template hierarchy:
config
config.oembed
config.oembed.article
config.oembed.article.type.picture

3.3 Organizing Templates
Template sections are organized in a hierarchy under the config section. The config section itself
is not a template. The config.default template is a child of the config section and is the root
of the default template inheritance tree. Beneath the config.default template are the standard
templates config.default.section, config.default.article, config.default.tag and
config.default.master:
config
config.default
config.default.section
config.default.article
config.default.tag
config.default.master
This part of the template hierarchy is fixed. Below this point, the templates and their hierarchical
structure are user-defined. The hierarchical structure is very important, since it governs how the
layouts in templates are combined by inheritance. For more about the details of how template
inheritance works, see section 3.5.

3.4 Templates, Section Pages and Content Pages
A template defines the graphical layout of a set of publication pages. That layout is stored in the
template section's active page. Its top-level structure consists of a set of areas representing the
publication's overall graphical structure. The default set of areas used in the demo publication
delivered with the Widget Framework consists of the following areas: Outer, Header, Top, Main,
Aside, Bottom and Footer. It also has a special area called Meta, which is used to hold "invisible"
widgets."Invisible" widgets affect how pages work in some way, but do not occupy any physical space
on the page.
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The exact physical position, shape and size of these areas is configurable - they are entirely determined
by CSS and may be device-dependent - but they will usually look something like this:
Met a
Header
Top

Main

Aside

Bot t om
Foot er

Each of these areas may have an internal structure of groups and areas. The Main area of a section, for
example, might have a Top Stories group and a Featured Stories group, each holding content
items whose teasers are to be placed in the main area of the page.
The physical shape, position and size of groups and areas are not shown when editing templates in
Content Studio:

The names of the groups and areas created within each top-level area, do however, usually describe
some of their physical characteristics (Two column and Three column groups, for example).
The section pages on which journalists and editors desk their stories in Content Studio have a very
different structure from the template pages on which they are based. A typical section page has only
one top-level area called ContentArea, which is subdivided into logical groups that have no direct
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relationship with physical page layout. These groups have names like Top stories, Featured
stories, Main, Carousel and so on:

There is, in other words, no direct correspondence between the groups on a section page and the
groups in the templates that govern its layout. In order for a content item that has been dragged into a
group on a section page to actually appear on the published page, it must be explicitly selected by one
of the widgets placed in the template.
For more information about this, and about widgets in general, see chapter 4.

3.5 Inheritance in the Widget Framework
As described above, all of a publication's templates have the same top-level structure: Meta,
Outer, Header, Top, Main, Aside, Bottom and Footer, for example. If a template
(config.default.section.news, for example) has widgets in all of these sections, then the
news section of the publication will take all of its layout from this template. If, however, only
the Aside area of the template contains widgets, then the Widget Framework will look in the
config.default.section template to get the layout for the Meta, Outer, Header, Top, Main,
Bottom and Footer areas. If config.default.section is not complete either (if, for example,
it's Outer, Header and Footer areas are empty) then the Widget Framework will look in the
config.default template for the missing information.
This inheritance mechanism makes it very easy to create a standardized layout for a whole publication,
and only create specialized layouts where you actually need them. A typical approach is to define
a standard layout for the Header and Footer areas in the config.default template, and
then define standard layouts for the remaining areas in the config.default.section and
config.default.article templates. If your publication has a very standardized layout, then this
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may be sufficient. If, however, some of your section pages have significantly different layouts, then
you can achieve that by creating config.default.section.name templates for those particular
sections, and overriding just those areas that are different from the standard layout. Similarly you can,
if necessary, create config.default.article.type templates for any content types that require
specialized layouts.
The Sports section in the following illustration takes its Header and Footer layouts from
the config.default template, and its Top, Main, Aside and Bottom layouts from the
config.default.section layout. The News section, however takes its Aside layout
from the config.default.section.news template, which overrides the Aside layout in
config.default.section:
config.default

config.default .sect ion

config.default .sect ion.news

Header

Header

Header

Top

Top

Top

Aside
Main

Aside
Main

Aside
Main

Foot er
Aside

Foot er
Aside

Foot er
Aside

Aside
Bot
t om

Aside
Bot
t om

Aside
Bot
t om

Foot er

Foot er

Foot er

Sport s sect ion

News sect ion

The following sections describe the specific inheritance mechanisms used for different types of page.

3.5.1

Section Template Inheritance

There are two different section template inheritance mechanisms, one governing the selection of
templates, and one governing the merging of the layout definitions in the sections. This section
describes how they are used to display a section called premierleague in a section hierarchy like
this:
ece_frontpage
sports
football
premierleague
with a corresponding template hierarchy that looks like this:
config
config.default.section
config.default.section.sports
config.default.section.football
config.default.section.premierleague
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Template selection
The Widget Framework first has to determine which template to select. In this case it is simple, since
the premierleague section has its own template (config.default.section.premierleague).
If there was no such template, however, then the Widget Framework would look for the template of its
parent section (football), and so on upwards. The Widget Framework bases its search on the section
hierarchy, looking for templates in the following order:
1.
2.
3.
4.
5.

config.default.section.premierleague
config.default.section.football
config.default.section.sports
config.default.section
config.default

Note that even though ece_frontpage is an ancestor of premierleague, its template is not
included in the lookup sequence. ece_frontpage is a special case, and its template is never used
for any other section.
Area layout selection
Once it has found a template (in this case config.default.section.premierleague) the
Widget Framework then tries to assemble a complete template, containing a layout for each top-level
area. In this case it bases its search on the template hierarchy rather than the section hierarchy. If, for
example, config.default.section.premierleague only contains a layout for the Aside area,
then it will continue to search for the Meta, Outer, Header, Top, Main, Bottom and Footer areas
in the config.default.section.football template. It will search the templates in the following
order, stopping once it has a complete set of layouts.
1.
2.
3.
4.
5.

config.default.section.premierleague
config.default.section.football
config.default.section.sports
config.default.section
config

With a flatter template hierarchy
The two search sequences described above are very similar because the template hierarchy closely
matches the section hierarchy. This need not be the case, however. If the template hierarchy looked
more like this:
config
config.default.section
config.default.section.sports
config.default.section.football
config.default.section.premierleague
then the template search sequence would be the same, but the layout search sequence would be:
1.
2.

config.default.section.premierleague
config.default.section
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3.

config

With a missing template
If there was no premierleague template at all:
config
config.default.section
config.default.section.sports
config.default.section.football
then the Widget Framework would start by using the template search sequence to select the football
section's template, config.default.section.football, and would then search for layouts in the
following sequence:
1.
2.
3.

config.default.section.football
config.default.section
config

3.5.2

Content Item (Article) Template Inheritance

Content item templates (or article templates) are all located under the config.default.article
template. You can create:
•

Specialized templates for specific content item types (for example
config.default.article.type.story and config.default.article.type.picture)

•

Specialized templates for content items belonging to specific sections (for example
config.default.article.premierleague or config.default.article.football)

•

Specialized templates for specific content item types belonging to specific sections
(for example config.default.article.premierleague.type.story or
config.default.article.premierleague.type.picture)

Below is a description of how the template and area layouts are selected for a story content item in
the premierleague section, assuming a section hierarchy like this:
ece_frontpage
sports
football
premierleague
Template selection
To find the correct template, the Widget Framework first looks for an article template of the correct
type for the correct section. If there is no such template, then it looks for an article template for the
correct section. If it still doesn't find a template then it repeats these two steps for the parent section,
(football), and so on up the section hierarchy:
1.
2.
3.
4.

config.default.article.premierleague.type.story
config.default.article.premierleague

config.default.article.football.type.story
config.default.article.football
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5.
6.
7.
8.
9.

config.default.article.sports.type.story
config.default.article.sports

config.default.article.ece_frontpage.type.story
config.default.article.ece_frontpage
config.default.article.type.story

10. config.default.article
11.

config.default

Area layout selection
This section describes the Widget Framework's default area layout selection mechanism, which
is based on the template hierarchy. In earlier versions of the Widget Framework, however, area
layout selection was based on the template naming convention. You can force the current version
of the Widget Framework to use this old area layout selection mechanism by setting the property
wf.conventionalInheritance to true in your publication feature resource.
The Widget Framework assembles content item layouts in the same way as section page layouts. If, for
example, config.default.article.premierleague.type.story only contains a layout for
the Aside area, then it will continue to search for the Meta, Outer, Header, Top, Main, Bottom
and Footer areas in the config.default.article.premierleague template.
If template hierarchy is like this:
config.default
config.default.article
config.default.article.type.story
config.default.article.type.picture
config.default.article.premierleague
config.default.article.premierleague.type.story
It will search the templates in the following order:
1.
2.
3.
4.

config.default.article.premierleague.type.story
config.default.article.premierleague
config.default.article
config.default

Section template hierarchy variations
Section template hierarchy variations such as a flatter structure or missing templates are handled in
exactly the same way as for section templates (see section 3.5.1).

3.5.3

Tag Template Inheritance

Tag pages are automatically generated pages created to display links and content related to tags.
When a user clicks on a tag keyword link, the corresponding tag page is displayed. The tag page usually
contains a brief article about or definition of the subject of the tag, followed by teasers and links
leading to tagged content items. The layout of these tag pages can be defined using tag page templates.
Tag page templates are all located under the config.default.tag template. You can create:
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•

Specialized templates for specific tag structures (for example
config.default.tag.scheme.places and config.default.tag.scheme.sports)

•

Specialized templates for specific tags (for example
config.default.tag.places.bangladesh or config.default.tag.sports.football)

Below is a description of how the template and area layouts are selected for a dhaka tag page,
assuming a tag structure like this:
places (Tag structure)
asia
bangladesh
dhaka
Template selection
To find the correct template, the Widget Framework first looks for a tag template for the specific
tag (dhaka). If there is no such template, then it looks to see if the parent tag (bangladesh) has
a template, and so on up the tag hierarchy. It will then check to see if there is a template for the tag
structure (places), and if not it will continue up the template hierarchy to the root:
1.
2.
3.
4.
5.
6.

config.default.tag.places.dhaka

config.default.tag.places.bangladesh
config.default.tag.places.asia

config.default.tag.scheme.places
config.default.tag
config.default

Area layout selection
Just like in case of section and article, area layout selection for tag templates follows the default
area layout selection mechanism, which is based on the template hierarchy.
The Widget Framework assembles tag page layouts in the same way as section page and content item
layouts. If, for example, config.default.tag.places.dhaka only contains a layout for the
Aside area, then it will continue to search for the Meta, Outer, Header, Top, Main, Bottom and
Footer areas in the config.default.tag.places.bangladesh template.
For example, if template hierarchy is like this:
config.default
config.default.tag
config.default.tag.scheme.people
config.default.tag.scheme.foods
config.default.tag.scheme.places
config.default.tag.places.asia
config.default.tag.places.bangladesh
config.default.tag.places.dhaka
then for the dhaka tag, it will search the templates for area layouts in the following order:
1.

config.default.tag.places.dhaka
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2.
3.
4.
5.
6.

config.default.tag.places.bangladesh
config.default.tag.places.asia

config.default.tag.scheme.places
config.default.tag
config.default

3.5.4

Custom Templates

Editors and journalists can override the template selection process for either a section page or a Story
content item by specifying a custom template. To do this the Content Studio user simply enter the
name of the required custom template in the section page's or Story's Custom template option.
In the case of a section page the Custom template option can be displayed by clicking on the section
page's Page Options button. For a Story content item the Custom template option is displayed on
the Layout tab. In both cases, the effect of specifying a custom template is that the custom template is
added to the start of the normal template search sequence. So if, for example, the name of a template
that does not exist is specified in the Custom template field, then the normal template will be used
instead.
Story Layout tabs also contain a Template variant field that provides similar functionality. Use of
this field is deprecated and the field will be removed in a future version. Use the Custom template
field instead.

3.6 Master Templates
The inheritance mechanism described in section 3.5 provides a useful means of re-using groups
of widgets. It only works, however, for whole areas. You can, for example, re-use the whole of a
template's Main area by creating a child template with an empty Main area. But what if you only want
to re-use one particular group of widgets, not the whole area? What if you want to re-use a group of
widgets from a template other than the parent of the template you are working on? Master templates
provide a more flexible means of re-using groups of widgets that solves these problems.
A master template has a name of the form:
config.default.master.master-template-name
and contains a set of templates that you want to be able to re-use. You might, for example, create a
menu that you want to re-use in many of your templates.
Once you have created a master template containing the widgets you want (let's call it
config.default.master.menu), you can use it by creating a master widget and placing it in any
section and/or article templates you like. A master widget has two required properties:
Title
The name of the widget instance you have created. You might set this to Menu.
Master section unique name
The name of the master template this widget is to reference. You would set this to
config.default.master.menu in this case.
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Set these properties, save the widget, and then drag it into the templates where you want to use the
widget group defined in the master template.
For a description of how you can enable editorial staff to quickly switch between master templates, see
section 7.9.

3.7 Lazy Loading
The Widget Framework uses Bootstrap-based CSS to enable responsive web sites that adjust page
layout to fit the available screen space. A page displayed on a mobile phone (or in a small window on a
PC) is formatted differently to the same page displayed full-screen on a PC.
This mechanism provides a good basis for making web sites that perform well on a wide range of
devices, but it is not sufficient in all cases. With the Widget Framework's lazy loading feature you can
also prevent parts of a web page from loading on certain devices.
You can individually configure the loading behavior of every part of a template (areas, groups and the
widgets placed in the template). By default all components are loaded in the normal way but you can
specify that certain components should only be loaded if the browser window is a certain size.
The loading behavior is controlled by options displayed in the Content Studio template editor:

When you select an area, group or widget, the options displayed on the right include the following lazy
loading options:
Lazy loading
Select the required value:
Enabled
This page component (area, group or widget) is not loaded if the browser window matches
a selected "skip" size.
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Disabled (default)
This page component (area, group or widget) is always loaded.
Skip on device
Check the window sizes for which loading is to be skipped.
Large
If checked, and Lazy loading is Enabled, then this component will not be loaded into
large browser windows.
Medium
If checked, and Lazy loading is Enabled, then this component will not be loaded into
medium browser windows.
Small
If checked, and Lazy loading is Enabled, then this component will not be loaded into
small browser windows.
You can determine the meaning of Large, Medium and Small yourself by setting section
parameters in the root section of your publication. The parameters (and their default settings)
are:
•
•
•

wf.clienttype.large=(min-width: 992px)
wf.clienttype.small=(max-width: 767px)

wf.clienttype.medium=(min-width: 768px) and (max-width: 991px)

Fragment token
An automatically generated ID is written to this field the first time a template is saved. You
should not modify this value.
Widget Framework's lazy loading mechanism is SEO-friendly. The fragments that are lazily loaded are
indexed by search engines. In order to make them indexable by search engines, Google's Ajax Crawling
Scheme is used.
Nested lazy loading is not supported. If you enable lazy loading for a group or area, then the loading
rule you specify is applied to that component and everything it contains. You cannot switch off lazy
loading for one of its child components, or apply a different loading rule. Any lazy loading changes
you make to child components will be ignored.

3.8 Overlays
A template overlay provides a mechanism for specializing a template. It allows you to conditionally
modify parts of a template. In this way, overlays provide a means of adding flexibility to blueprints:
•

Blueprints make it possible to enforce a common look and feel across a family of related
publications

•

Overlays make it possible for publications to deviate from the common look and feel in a controlled
way in order to reflect their unique identity, acknowledge important events or align with local
markets

Your publications might, for example, have a similar overall layout, as defined in a shared blueprint,
but unique headers and footers defined in publication-specific overlays. You might want to change the
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appearance of your sports section in some publications to mark the football World Cup. You can do
this by adding a "worldcup" overlay to your blueprint and specifying that you want the overlay to be
applied to the sports sections in those publications. You might want some publications or sections to
have layouts that vary according to the markets they primarily address. You can do this in the same
way: add suitable overlays to your blueprint, and then set up the appropriate publications or sections
to use them.

3.8.1

How Overlays are Selected

An overlay is a specially-named template that you can insert into a blueprint's template tree at any
point. An overlay has the same unique name as its parent template, with a prefix of the form:
overlay.key.
where key is a string that identifies the overlay. A template with the unique name
config.default.section.sports, for example, might have child overlays with
the unique names overlay.dailynews.config.default.section.sports and
overlay.worldcup.config.default.section.sports.
These overlays will be activated and actually modify the parent template if their keys (dailynews and
worldcup respectively) match either:
•

The name of the current publication, or

•

A key specified in the wf.overlays parameter of the current section (the section to which the
config.default.section.sports template is being applied). wf.overlays is a section
parameter that can contain a comma-separated list of overlay keys, for example:
wf.overlays=worldcup,northeast

An overlay with a key that matches a publication name is usually referred to as a publicationspecific overlay, while an overlay with a key that does not match any publication name is referred to
as an opt-in overlay, because it is only used in publications or sections where the editor has actively
opted in by setting a section parameter.
If the current publication is called dailynews, then config.default.section.sports
will be modified by applying overlay.dailynews.config.default.section.sports. If
the current section has wf.overlays set as shown above, then it will be modified by applying
overlay.worldcup.config.default.section.sports. If both conditions are met, then both
overlays will be applied, but overlay.dailynews.config.default.section.sports will have
the highest priority if the overlays conflict in any way (publication name matches are always given the
highest priority).
If the config.default.section.sports template also had a northeast overlay
(overlay.northeast.config.default.section.sports), then that would also be applied in
this case, but it would have the lowest priority of all three overlays, since the keys in wf.overlays are
specified in order of decreasing priority.

3.8.2

How Overlays Work

There are two different types of overlay, called inheritance overlays and selective overlays. They
differ both in structure, and in how they work.
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3.8.2.1

Inheritance Overlays

If an inheritance overlay's activation conditions are met, then it works in exactly the same way as an
ordinary template. It has the same top-level areas as an ordinary template, and need not have content
in all of them. If a top-level area has any content, then it completely replaces the content of the same
area in the parent template.

3.8.2.2

Selective Overlays

Selective overlays provide a more granular mechanism for overriding template content: they allow
you to specify exactly which parts of a template you want to override – you aren't limited to overriding
entire top-level areas.
A selective overlay does not have the same top level areas as an ordinary template. Instead it has a
single top-level area called Overlay config area. In this area you can add one or more Area overlay
and/or Group overlay groups:

Overlay config area

•

An Area overlay group contains an overlay for a named top-level area (so an area overlay doesn't
in fact offer any more granularity than an inheritance overlay). It has a Referenced area option
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that you must use to specify the area that it is to replace. The option only allows you to select toplevel areas.

An area overlay cannot be used to replace the top-level area of a master template. Neither can it
be used to replace the top-level area of an inline template.
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•

A Group overlay group contains an overlay for a named group. You can therefore use it to replace
any part of a template, not just top-level components. It has a Referenced group option that you
must use to specify the group that it is to replace.

Copyright © 2010-2017 Escenic AS

Page 29

Escenic Widget Framework User Guide

4 Widgets
A widget is a template fragment: a bundle of HTML, JSP and CSS code that performs a particular
function such as displaying a content item or dateline on a publication page. As a publication designer,
however, you do not need to think about this internal structure: you will see widgets as special content
items that you can work with in Content Studio in much the same way as ordinary content items.
You can create, delete and modify them in much the same way as ordinary content items. The main
difference is that widgets are placed in templates (the special section pages described in chapter 3)
rather than in ordinary section pages.

4.1 About Widgets
Widgets fall into the following main categories:
•

Content-based widgets

•

Content-free widgets

4.1.1

Content-based Widgets

A content-based widget is a widget that renders all or part of one or more content items. There are two
types of content-based widget:
•

Widgets that render the current content item and are therefore used only in content templates and
tag templates (in which case the tag's topic content item is the current content item). The Content
Body widget is an example of this kind of widget.

•

Widgets that can render information about many widgets and are therefore primarily used in
section templates. Such widgets may also be used in content templates (to render information
about a content item's related items, for example). The only widgets of this kind at present are the
Teaser widget and the related Teaser View widget.

4.1.2

Content-free Widgets

A content-free widget does not require access to any particular content items, and can be used in both
content templates and section templates. The Menu widget, Code widget and Breadcrumb widget are
all examples of this kind of widget.

4.1.3

Data Sources

The Teaser widget performs two functions:
•

It retrieves a set of content items from the Content Engine.

•

It renders selected fields and information about each of the content items in the set.

The widget's data retrieval function is performed by a component called a Data Source. A Data Source
is actually an independent, separate component and can be used in three ways:
•

Embedded in a widget
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•

Defined independently and then used by one or more "client" widgets

•

Desked in a group on the section page, where it behaves like an automated list

The Data Source component is very powerful and flexible. It allows you to define multiple queries that
can select content items using a variety of different methods. You can, for example:
•

Select the content items desked in a specified group on the current section page

•

Select the current content item's related content items

•

Select content items that are tagged with the same tags as the current content item

•

Select content items based on data returned by the Escenic Analysis Engine (the most read content
items, for example)

•

Select content items using a free text search

The results returned by the queries you define are merged into a single collection that you can filter
and sort in various ways to produce the final list of content items that will be displayed by a widget or
widgets (or directly on a section page in the case of a desked data source).
4.1.3.1

Desked Data Sources

Although data sources are primarily intended to be used as the "back end" of widgets, they can also be
used independently by editorial staff as a means of creating automated lists. If a data source is desked
directly on an ordinary section page, then it behaves something like a list: on the published page, it is
replaced by the content items that it retrieves.
Data source nesting
A data source with a "by section group" query selects content items from a section page group, and that
section page group may itself contain a data source. This kind of data source nesting is allowed, but
limited in order to prevent complex chains of nested data sources and/or loops. The limit can be set
by configuring the Widget Framework's /com/escenic/framework/datasource/fetcher/
DeskedItemFetcher component. This component has a maxDatasourceNestingLevel property
that limits nesting as follows:
maxDatasourceNestingLevel Meaning
0

Desked data sources are ignored

1

Desked data sources are used, but any further nesting is ignored

2

Desked data sources are used. If a desked data source selects from
a section page group containing another data source, then that data
will be used, but any further nesting is ignored

n...

And so on ...

By default, maxDatasourceNestingLevel is set to 1.
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4.2 Widgets and Widget Types
So far in this manual, we have often used the word widget to mean widget type (it's difficult to avoid
doing so), but it is important to clearly understand the difference between the concepts widget and
widget type. If you click on File > New > (Core/Community) Widgets in Content Studio, then
what you see in the displayed menu is a list of widget types. If you click on one of the listed types let's say you click on Menu Widget - then this results in the creation of an actual widget, an instance
of the widget type Menu. One of the things you are required to do when you create any kind of widget,
is to name the instance you have created by setting it's Name property. The following illustration shows
the property list for a newly-created menu widget: the Title label is displayed in red, indicating that
this property is required.

Naming the widgets you create is important, because you can create many widgets of the same type.
You might, for example, call your Menu widget Header Menu, and place it in the Header area. But
if you also want your publication to include a footer menu, then you can create another Menu widget
called Footer Menu and set it up accordingly. A typical content template will usually contain several
instances of the Content Field widget type, each set up to display a different content item field: a
Title widget displaying the title field and a Subtitle widget displaying the subtitle field, for
example.

4.3 Creating a Widget
A widget is special kind of content item, so you can create one in the same way as any other content
item:
1.

Select File > New > Widgets.

2.

the type of widget you want to create - Teaser Widget for example.

3.

Configure the widget by entering values in its property fields.

4.

Click on Save or Publish.

All widgets have at least one mandatory property field (displayed in red) that you must fill in: Title,
the name that will be used to identify the widget. Some widget types may have other mandatory
properties.
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Widgets may have many other property fields, but usually most of them will have default values. The
fields are divided into groups and displayed on separate tabs. Mandatory property fields always appear
on the default General tab. For more information about property fields and how they are organized,
see section 4.4.
In addition to the General tab, most widgets have an Default tab and an Advanced tab. Some
widgets have no additional tabs, others have many.

4.4 Configuring a Widget
Configuring a widget is a simple matter of opening it in Content Studio and setting its properties.
There are very few properties that must be set in order for a widget to work, and most properties
have sensible defaults, so configuring widgets is in general not particularly difficult. Moreover, many
properties are common to most or all widget types, so once you have learned what these common
properties control, learning to use new widget types does not require much additional effort.
Widget properties are divided into groups and displayed on separate tabs. The following three tabs are
common to almost all widget types:
•

General

•

Default

•

Advanced

The properties most commonly displayed on these tabs are described in the following sections. Some
widget types have only these three tabs. Other widget types have additional tabs containing widgetspecific properties that are for the most part not discussed in this manual. For information about
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widget-specific properties, see the widget descriptions in the Escenic Widget Framework Core Widgets
Reference.

4.4.1

General Properties

A General properties tab contains some or all of the following property fields:
Title
This property is always mandatory. Use it to set the name of the widget.
View
Many widgets have a View property. It is intended to allow switching between different widget
views. In the current version, however, it has only one value: Default.

4.4.2

Default Properties

Most widgets have a Default tab, and it usually contains the widget's most commonly-used settings.

4.4.3

Advanced Properties

An Advanced properties tab usually contains the following property fields:
Widget wrapper
The HTML elements that make up a widget are always wrapped in a single HTML element. This
property lets you choose what element to use for this purpose.
Style Id
This property lets you set the widget wrapper element's id attribute, so it can easily be selected
in CSS files. This attribute is mainly of interest to theme designers.
Style Class
This property lets you set the widget wrapper element's class attribute, so it can easily be
selected in CSS files. This attribute is mainly of interest to theme designers.
Enable Edge Side Includes (ESI)
Check this property to enable Edge Side Includes (ESI) processing of this widget. ESI is
a widely-used standard for caching of web pages (see http://www.edge-delivery.org/). If you
check this option, then the HTML code representing the widget is wrapped in ESI mark-up
specifying that it may be cached by ESI servers. You can specify that some widgets are cached,
while others are not, and you can specify how long different widgets should be cached for. You
may, for example, decide that a widget whose content changes infrequently can be cached for a
long time. Other widgets with more volatile content can be set up to expire more frequently, or
not cached at all.
Do not enable this option unless:
•

You know what ESI is and understand how to use it

•

You know that the generated output will be processed by an ESI server

Maximum age (in seconds)
If you have checked Enable Edge Side Includes (ESI), then you must use this property to
specify how long the widget may be cached by the ESI server. The ESI server will only use the
cached version of the widget until this limit is reached.
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Set cache control directive
If you have checked Enable Edge Side Includes (ESI), then this property controls the value
of a cache control directive included in the header of the response generated when a caching
server requests a new version of this widget. It can be set to one of the following values:
public (the default)
The widget has public content that is valid for all users. The cached copy can therefore be
used for all page requests.
private
The widget has user-specific content that is not valid for all users. It should therefore be
saved in a private user-specific cache and only used for responding to requests from that
user.
no-cache
The widget should not be cached at all.
The Advanced properties tab of some widget types may also contain other widget-specific properties.

4.4.4

Configuring Teaser Widget Data Sources

A Teaser widget renders selected fields from a set of selected content items. The content items are
selected by a component called a Data Source. A Teaser widget therefore has a Data Source tab that
you can use to configure the Data Source. There are two different types of Data Source:
External
An external Data Source is independently-defined: you create it in the same way as a widget.
You can then use it in a Teaser widget by dropping it on the widget's External Data Source
field as a related content item.
Embedded
An embedded Data Source is embedded inside the Teaser widget. You configure it by editing the
Embedded Data Source definition form displayed on the Data Source tab.
A widget can only have one data source, so before you configure a Teaser widget, you first need to
decide what kind of Data Source to use. You should use an external Data Source if you want several
widgets to be able to share the same Data Source. Otherwise it is most convenient to have the Data
Source definition embedded in the widget that uses it. To select the Data Source type you must set the
Use field (which is the first field on the Data Source tab) to External Data Source or Embedded
Data Source.
If you select Embedded Data Source then you can configure the embedded Data Source using
the form displayed in the Embedded Data Source definition field. If you select External Data
Source then you need to create a Data Source, save it and then associate it with your Teaser widget by
dropping it on the widget's External Data Source field as a related content item.
To create an external Data Source, select File > New > Data Source and then configure it in the
same way as you would configure a widget. The Data Source component has a Definition field that
contains exactly the same Data Source configuration form as the Teaser Widget's Embedded Data
Source definition field. For a complete description of this form and how to use it, see Configuring a
Data Source.
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4.4.5

Configuring View Pickers and Teaser Views

Using an external Data Source component allows you to decouple the Teaser widget's back-end data
retrieval function from its front-end presentation functionality. The Teaser View widget performs a
similar function with regard to the Teaser widget's front end. A Teaser View widget has all the same
presentation functionality as a Teaser widget, but no back-end functionality at all. It does not have an
embedded Data Source, nor any means of attaching an external Data Source. A Teaser View widget can
only be used in combination with a View Picker widget.
A View Picker widget can be regarded as a kind of switch that connects one Data Source to several
Teaser View widgets. Like a Teaser widget, a View Picker widget can be configured to use either an
embedded Data Source or an external Data Source. Unlike a Teaser widget, however, the View Picker
widget has no front-end presentation functionality. Instead, it has a Related view field on which you
can drop Teaser View widgets. You can then configure the Teaser View widgets to select content items
from the View Picker's Data Source. The Teaser View widgets can select content items based on two
criteria:
•

Content type

•

Position in the Data Source collection

The procedure for configuring these widgets is as follows:
1.

Create and configure the Teaser View widgets you require. A Teaser View widget is identical to a
Teaser widget, except that it has no Data Source tab.

2.

Save/Publish the Teaser Views. Note, however, that these widgets cannot be placed on a
template in the normal way.

3.

Create and configure a View Picker widget. You can configure it with either an embedded Data
Source or an external Data Source in the same way as a Teaser widget.

4.

Drop the Teaser View widgets you created on the View Picker's Related view field.

5.

Select each dropped Teaser View widget in turn and edit its content item selection properties.
These properties are displayed in the Element properties panel on the right. Note that you
can only edit these properties here - you cannot edit them when editing the Teaser View widgets
themselves.

6.

Save/Publish the View Picker widget.

7.

Place the Teaser View widget in the required location in a template.

4.5 Adding a Widget to a Template
Since widgets are represented by content items in Content Studio, you can add a widget to a template
in exactly the same way as you would add a content item to an ordinary section:
1.

Click on Sections on the left side of the window to display the Sections tab.

2.

Locate the template you want to add a widget to in the section tree
(config.default.section, for example: this is the default template for all section pages).
Double-click on the section to open it.

3.

Click on Search on the left side of the window to display the Search tab.

4.

Clear the Date field and click on the Widgets link. All available widgets will then be listed in
the search results area. If you know the name of the widget you want, you can also enter a search
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string in the Find field before clicking on the Widgets link in order to list only the widget you
are interested in.
5.

Locate the widget you are interested in and drag it from the search results list to the required
location in the template you opened.
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5 Themes
The graphical appearance of Widget Framework publications can be controlled by selecting themes.
A theme is a package of CSS files, graphics files (button icons, and so on) and javascript files that
determine the appearance and behavior of the templates. A theme can also have variants. A variant
contains modifications to some aspects of a theme.
You can use themes and variants in whatever way you choose, but the general idea is that you can use
different themes for different publications that you want to have completely different appearances, and
use variants on those themes for minor variations within publications at the section level (so that the
Sports section looks different from the News section, for example).
The Widget Framework is supplied with one theme called default, which has an empty variant called
variant. It is possible to make themes and variants of your own (if you have the necessary CSS and
Javascript programming skills). This manual does not, however, cover the design and creation of
custom themes and variants.
Themes and variants can be set on a per-section basis, allowing you to give a different look-and-feel to
different parts of a publication. For a description of how to do this, see section 5.1.

5.1 Changing Themes and Variants
To change the theme or variant of a section you must have section editing rights for the sections
you want to change. You need to open the section for editing in Content Studio and set some section
parameters:
1.

Open the Content Studio Sections panel and expand the section tree to display the section you
are interested in.

2.

Select the section and right click on it to display its context menu.

3.

Select Edit from the context menu.

4.

Click on the Section parameters tab in the opened section editor.

You can now set the following section parameters:
theme.name=your-theme

to set the theme, or
theme.variant=your-variant

to set the variant
Section parameters are inherited, so when you change a section's theme or variant in this way, the
change also applies to all the section's sub-sections. The appearance of an entire publication can be
changed by setting the root section's theme.name parameter.
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6 Access Control
With the introduction of the Widget Framework, Content Studio becomes a tool not only for writers
and editors, but also for publication designers and layout experts. In some cases, the same people may
be responsible for both kinds of work, but in most organisations (especially in larger ones) these jobs
will be carried out by specialists.
Since the Widget Framework's templates are in fact sections, you can use the standard Content Engine
access control mechanisms to enforce this division of labour. All you need to do is create separate user
groups for editorial and design staff, and then assign them different section-level access rights. You
might, for example, assign the following access rights:
•

•

Design staff: editor or journalist access to templates (the config section and its
subsections), reader access to content sections. If you are using separate publications for
maintaining your sites and their design configuration, your design stuff should be given editor or
journalist access to the blueprint publications and reader access to the site publications.
Editorial staff: editor or journalist access to content sections, no access to templates. If you
are using separate publications for maintaining sites and configuration, editorial stuff should be
given editor or journalist access to the site publications, and no access to blueprints.

You can, of course, specify access rights in more detail, creating sub-groups of designers with greater
or lesser access to different templates, and give some individuals specialised access rights.
For a detailed description of Content Engine access control and how to use it, see Editing Users and
Persons in the Escenic Content Engine Publication Administrator Guide.
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7 How To...
This section contains some step-by-step descriptions of how to carry out specific tasks using the
Widget Framework. The first few examples are based on the following scenario:
•
•
•

You have three publications that share a blueprint called blueprint-main.
They all have an existing section called Sports, based on a template called
config.default.section.sports.
You want to add a new section under the Sports section called Tennis.

•

You want the Tennis section to have a slightly different layout to the other Sports sections, so
you need to create a new template for it.

•

You want both publications to have the same layout except for the page header, which will be
different in each publication, so you need to create an overlay for each publication that defines its
header.

•

Two of the publications change the layout of the Sports page for the football World Cup, so you
need to create an overlay that can be shared by both of these publications and easily activated for
the duration of the world cup.

In order to achieve these objectives you need to:
1.

Create new Tennis sections (see section 7.1) in each publication.

2.

Create a template in blueprint-main that defines the layout for your new sections (see section
7.2).

3.

Edit the new template (see section 7.3).

When you have carried out these tasks, add some content to your Tennis section and view the results
in a browser. You should see that the Tennis section's layout is different from that of other Sports
sections.

7.1 Create a Section
To create a new Tennis section in your publications, do the following:
1.
2.

Start Content Studio and log in as a user with editor access to the publications.

In each publication, create a new Tennis section as a subsection of the Sports section. For
general information on how to use Content Studio, see the Escenic Content Engine User Guide.
Set each new section's Unique section name to tennis.

7.2 Create a Template
To create a new template for your Tennis sections:
1.

Start Content Studio and log in as a user with editor access to blueprint-one.
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2.

Follow the general instructions in section 3.1 (steps 1 to 5). Create your new template as a
subsection of config.default.section.sports, and set its properties as follows:
Section name
Tennis page template
Unique section name
config.default.section.tennis
Relative directory URI
config_default_section_tennis
The last section of the template's Unique section name must exactly match the Unique
section name of the sections it defines the layout for. If this is not the case, then the template will
not be found by the widget framework and will not be used.

7.3 Edit a Template
To edit your tennis template:
1.

Start Content Studio and log in as a user with editor or journalist access to blueprintone.

2.

Find the new template (config.default.section.tennis) and open it.

3.

You will see that the new template is empty: this means that it inherits all of its layout from its
parent, config.default.section.sports. Open config.default.section.sports,
copy the contents of its Main area, and paste them into the Main area of
config.default.section.tennis.

4.

Now make a change to the widgets you have pasted into config.default.section.tennis:
simply delete one of the widgets, for example, or replace it with a different type of widget.

5.

Click on Save or Publish to save your changes.

7.4 Preview a Template
You can preview a template you are working on in Content Studio in just the same way as editors can
preview content items and section pages. The main difference is that in order to preview a template,
you need to supply some content as well. Therefore, when you display a templates Preview tab, the
options panel on the right contains an additional Widget Framework section where you can specify
the content you want to use for preview purposes:
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You can simply drop a content item or content section page from one of your publications in the
Content field, or select one you have used earlier from the corresponding Recent field. Valid content
depends on the type of template you are previewing.
•

Content template: Only content items are allowed.

•

Section template: Only sections are allowed.

•

Master template: Both content items and sections are allowed.

•

Content profile root template: Both content items and sections are allowed.

You can change the selected content item or section to see what the template looks like with different
content.
The Preview with overlay option determines whether or not overlays (see section 1.1.2.1) will
applied to the preview. By default, this option is selected. That means that overlays will be applied
to the preview if appropriate. Whether or not overlays are actually applied (and in that case, which
overlays) depends on what you drop in the Content drop zone. The same rules that determine which
overlays are applied to real content are used to determine which overlays are applied to the preview
content. If, for example, the template has a publication-specific overlay, then whether or not the
template is applied will depend on which publication your chosen preview content belongs to.

7.4.1

Previewing an Overlay

You can preview overlays (see section 1.1.2.1) as well as templates, and overlay previews work in more
or less the same way: you need to drop some appropriate content in the Content field in the options
panel on the right. An overlay preview, however, is different from a template preview in two ways:
•

No Preview with overlay option is not displayed in options panel

•

The parts of the preview that are generated from the referenced template and not modified by the
overlay, are grayed out slightly, in order to highlight the effect of the overlay:

7.5 Set Publication Blueprint
The layout of a site publication is determined by its blueprint. You can set the blueprint of a site
publication in two different ways:
•

If your Content Engine installation includes the Snapshot plug-in, then you can use the Snapshot
plug-in to very simply set the publication's active blueprint from within Content Studio.

•

If you do not have access to the Snapshot plug-in, then the process is rather more complicated:
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1.

From escenic-admin, download the publication's feature resource

2.

Open the feature resource in an editor

3.

Set the following property (add it if necessary)
blueprint.active = blueprint-name

4.

Upload the modified feature resource to the Content Engine.

For general information on how to upload updated publication resources to the Content Engine, see
Update Resources.

7.6 Create a Publication-Specific Overlay
If all your publications are based on the same blueprint, then they will have the same look and feel.
What if you want to differentiate the publications slightly, by giving each one its own page header
layout, for example? You can do this by creating publication overlays.
First of all, find out where the page headers are defined. A header is typically the same on all pages
of a publication – both article pages and section pages. The header is therefore usually defined in the
config.default template. If this is the case, then you can specialize the header of your dailynews
publication as follows:
1.

Start Content Studio and log in as a user with editor or journalist access to blueprintone.

2.

Find the default template (config.default) in the section tree and right-click on it.

3.

Select Create subsection... from the displayed menu.

4.

Fill the fields in the new template as follows:
Section unique name
Enter overlay.dailynews.config.default. The second part of the name (called
the overlay key) must be the name of the publication you want to specialize. It must be an
exact case-sensitive match for the publication name.
Section name
Enter a short string (one character is enough). You are required to enter a name in this
field, but whatever you enter will be replaced with an automatically generated name of the
following form:
<key> parent-name
where key is the name of the publication that is to make use of this overlay (i.e
dailynews) and parent-name is the title of the parent template the overlay will modify
(i.e Default).
Relative directory URI
You can leave this blank: it will be filled with an automatically generated name.

5.

Save the overlay and close it.

6.

Double-click on the new overlay in the section tree to open its section page editor. You will see
that the section page is completely empty.

7.

Double-click on the new overlay's parent template (config.default) to open its section page
editor.
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8.

Select everything in config.default's Header area, right click and select Copy from the
displayed menu.

9.

Switch tabs to the overlay editor, right-click on the Header area and select Paste from the
displayed menu.

10. Make whatever changes you require to the layout components you have pasted in to the header.
11.

Click on Publish to save and publish your changes.

You have now created a specialized page header for your dailynews publication. All pages in the
dailynews publication should have a different header from the pages in your other publications.
You can specialize your other publications' headers by creating corresponding overlays for them
(overlay.weeklyrag.config.default and overlay.monthlyreview.config.default, for
example).

7.7 Create an Opt-in Overlay
Sometimes you need to create template specializations that are not tied to a particular publication. You
might, for example, want to modify some aspect of the layout in certain sections of one publication,
or in the same section of several publications (but not all of them). You also might want to be able to
easily turn such specializations on and off. You can do this by creating opt-in overlays. Creating
an opt-in overlay is almost the same as creating a publication overlay: the only difference is that the
overlay key you choose when naming the overlay must not match the name of any publication that
uses the blueprint, otherwise it will be used by that publication as a publication overlay.
Once you have created an opt-in overlay, it will only be used in publications or sections
where it is actively selected. If you have created a Sports section opt-in overlay called
overlay.worldcup.config.default.section.sports, then in order to activate in a particular
publication you would need to:
1.

Start Content Studio and log in as a user with editor or journalist access to the publication
you are interested in.

2.

Find the Sports section (config.default.section.sports) in the section tree and rightclick on it.

3.

Select Edit from the displayed menu.

4.

Click on the Section parameters tab in the opened editor.

5.

Look for the parameter wf.overlays in the Section parameters field.

6.

If you find an existing wf.overlays parameter, add worldcup to its list of values (commaseparated). If you can't find a wf.overlays parameter, then add it yourself:
wf.overlays=worldcup

7.

Save and close the section.

Whatever specialization you defined in your worldcup overlay should now be visible in the Sports
section of the publication you modified (and all the Sport sections' subsections), but not in the Sports
sections of the other publications that share the same blueprint. You can, however, add it to other
Sports sections by adding the wf.overlays=worldcup setting to them as well.
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7.8 Create a Selective Overlay
The overlay created in section 7.6 is an inheritance overlay: it is applied using the normal template
inheritance mechanism, where any top level area that isn't empty automatically overrides the
corresponding top-level area in the parent template. This works perfectly well, but in some cases you
may want a bit more control. In particular, you may want to override only part of a top-level area.
To create the same specialization as you created in section 7.6 using a selective overlay you would need
to:
1.

Start Content Studio and log in as a user with editor or journalist access to blueprintone.

2.

Find the default template (config.default) in the section tree and right-click on it.

3.

Select Create subsection... from the displayed menu.

4.

Fill the fields in the new template as follows:
Section unique name
Enter overlay.dailynews.config.default. The second part of the name (called
the overlay key) must be the name of the publication you want to specialize. It must be an
exact case-sensitive match for the publication name.
Section name
Enter a short string (one character is enough). You are required to enter a name in this
field, but whatever you enter will be replaced with an automatically generated name of the
following form:
<key> parent-name
where key is the name of the publication that is to make use of this overlay (i.e
dailynews) and parent-name is the title of the parent template the overlay will modify
(i.e Default).
Relative directory URI
You can leave this blank: it will be filled with an automatically generated name.

5.

Save the overlay and close it.

6.

Double-click on the new overlay in the section tree to open its section page editor.

7.

From the menu bar, select Tools > Change layout.

8.

In the New layout field of the displayed dialog box, select Overlay config. You will see that the
template's layout now consists of a single top-level area called Overlay config area.

9.

Right-click on the Overlay config area and select Insert > Insert new Area overlay
group from the displayed menu.

10. Click on <untitled> and enter a name for the new group (Header Overlay, for example).
11.

Click in the Referenced area field (in the options area on the right) and select Header.

12.

In the section tree, double-click on the new overlay's parent template (config.default) to
open its section page editor.

13.

Select everything in config.default's Header area, right click and select Copy from the
displayed menu.

14.

Switch tabs to the overlay editor, right-click on the group you created and select Paste from the
displayed menu.
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15.

Make whatever changes you require to the layout components you have pasted in to the header
overlay.

16.

Click on Publish to save and publish your changes.

An overlay created in this way does exactly the same thing as an inheritance overlay: it replaces the
entire Header area of the overlay's parent template. This may not always be exactly what you want:
maybe the Header area contains four or five groups, and you've only actually made a change in one of
them. This unnecessary duplication increases your maintenance overhead: if you modify the header in
the future, then you will probably need to modify the overlay as well to keep them synchronized.
To avoid such unnecessary duplication, you can create a selective overlay that only contains the
specific group you want to modify. To do this you follow the same procedure, with the following
changes:
•

At step 9, select Insert > Insert new Group overlay group instead of Insert > Insert new
Area overlay group.

•

At step 11, click in the Referenced group field (in the options area on the right) and enter the
name of the group you actually want to modify.

•

Replace steps 13 to 16 with the following:
1.

Select the group you want to overlay.

2.

In the group options on the right, check the Allow override option. This is an important step
– if you don't do it, then you won't be able to create the overlay.

3.

Right click on the group and select Copy from the displayed menu.

4.

Switch tabs to the overlay editor, right-click on the group you created and select Paste from
the displayed menu.

5.

Make whatever changes you require to the layout components you have pasted in to the
header overlay.

6.

Click on Publish to save and publish your changes.

7.9 Enable Master Template Switching
Master template switching is a technique you can use to provide editorial staff with a very quick way
to switch between different layouts. A typical use case is "instant" reformatting of the front page when
a big story breaks. Under normal news conditions a "default" layout gives two or three top stories
broadly similar prominence. When a big story breaks, however, editorial staff want to switch to a
"breaking news" layout in which much greater prominence is given to the number one story, and less
to the other top stories.
Master template switching allows editorial staff to make this kind of change by simply changing a
section page option in Content Studio.
To set up master template switching:
1.

Create the master templates you want to switch between (say
config.default.master.frontpage.default and
config.default.master.frontpage.breaking). These master templates should contain
sets of correctly configured widgets that you have tested in the location where you intend to use
them.

Copyright © 2010-2017 Escenic AS

Page 46

Escenic Widget Framework User Guide

2.

Add a template switching option to one of the groups on the required section page. To do this you
have to edit your publication's layout-group resource and add a structure something like this:
<group name="topStories">
...
<ct:options>
<ct:field name="masterconfig" type="enumeration">
<ui:label>Select page layout</ui:label>
<ui:description>Master configuration option for the group</ui:description>
<ct:enumeration value="frontpage.default">
<ui:label>Default</ui:label>
</ct:enumeration>
<ct:enumeration value="frontpage.breaking">
<ui:label>Breaking news</ui:label>
</ct:enumeration>
<ui:value-if-unset>frontpage.default</ui:value-if-unset>
</ct:field>
</ct:options>
...
</group>

The important points about this option definition are:
•

It must be called masterconfig.

•

It should be an enumeration field with one enumeration element for each master template
that you want to switch between.

•

The value attributes of the enumeration elements must either be:
•

•

the names of the master templates you have created, but without their master
template prefix (that is, mymaster, not config.default.master.mymaster or
config.mycontentprofile.master.mymaster), or

the special keyword auto. This causes the Master widget's Master section unique
name to be used.

See here in the Escenic Content Engine Template Developer Guide for information about
the layout-group resource and how to edit it.
3.

Add a Master widget to the template used by the section page.

4.

Set the following fields in the Master widget:
Title
Set to anything you like.
Master section unique name
Set this to the name of any one of your master templates (for example
config.default.master.frontpage.default). The template you specify here will
get used if:
•
•

The Master widget is used on a section page that has no masterconfig option, or
The user selects an option containing the special keyword auto.

Master group name
Set this to the name of the section page group to which you added the masterconfig
option (topStories in the example shown above) Make sure that you use the name of
the group (as specified in the layout-group resource) and not its label as displayed in
Content Studio. These may be the same, but are not necessarily so.
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If there are several section page groups with the same name on the page, then you must
specify which one you want by appending an index to the name, as follows:
name-index

All the groups are numbered in a single sequence, even if they belong to different areas,
and they are numbered from one. So if a section page contains two areas, the first area
contains one group called myGroup and the second area contains two groups with the same
name, then in order to identify the second group in the second area, you would need to
specify myGroup-3.
Make sure that all the changes you have made are published. You should now be able to switch
between the layouts you have defined by simply changing the value of the masterconfig option you
added to the section page and pressing Publish in Content Studio.

7.10Add Search Functionality
To add search functionality to a typical publication you need to:
•

Design and create a search results page

•

Add a search box to every page

These tasks are described below.

7.10.1 Creating a Results Page
To create a results page:
1.

Create a search results section as a child of the publication's home section. Set the section's
Section unique name property to search.

2.

Create a template for the search results page as a child of the publication's
config.default.section template. The new template's Section unique name must be set
to config.default.section.search.

3.

Create a Search Config widget and configure it according to your needs, then publish it.

4.

Drag the Search Config widget into your search template's Meta area.

5.

Create a Search Component widget, set Title to a name of your choice (Search Results, for
example).

6.

On the General tab, set Component to Results List.

7.

Publish the widget.

8.

Drag the Search Results widget into your search template's Main area (probably inside a group
somewhere).

9.

If you want other search components on your search page, create other kinds of Search
Component widgets (a result counter and a pager control, for example) and place them in your
search template.

10. Publish the template.
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The following screenshot shows a typical search results page template:

7.10.2 Adding a Search box to Pages
To add a search box to the pages of your publication.
1.

Create a Search Component widget.

2.

On the General tab, set Title to a name of your choice (Search Box, for example).

3.

On the General tab, set Component to Search Box.

4.

On the Search Box tab, set Target section to point to the search results page you have created
(see section 7.10.1). If required, set other fields on this tab as well.

5.

Publish the widget.

6.

Open your config.default template.

7.

Drag your new search box template into the template (usually into the Header or Outer area).

8.

Publish the template.

Adding your search box to the config.default means that it will appear on every page of your
publication. Should you not want this, you would need to add it to a different template or templates.
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7.11Load Content In-line
The Widget Framework supports in-line loading of content items. What this means is that when a user
clicks on a link (for example, a teaser link on a section page), then instead of a new page being loaded,
the content item referenced by the teaser is loaded into an area on the current page.
In order to achieve this behavior you need to do two things:
•

Configure a Teaser or Teaser view widget to perform in-line loading instead of normal linking.
You do this using the widget's Link settings, which you will find on its Default tab. See The
Default Tab.

•

Create one or more config.inline.article templates for displaying the in-line content. See
section 3.2.1.1 for further information.

7.12Enable/Disable Profiling
The Escenic Content Engine has a JSP profiling facility that can be useful for tuning purposes.
Profiling is not enabled by default Widget Framework publications because it carries a small
performance penalty (less than 1%).
You can turn on profiling by setting the following section parameter (usually in the root section of your
publication):
jsp.statistics=on

You can turn it off again for part of a publication by setting it to off in a particular section:
jsp.statistics=off

7.13Display "Mega-Dropdown" Using Menu Pane Group
Displaying a menu directly in a Menu Pane group enables more complex menu layouts than using a
Menu widget. You can easily create a menu containing "mega-dropdown" panes with complex multicolumn layouts.
To display a menu in this way, add a Menu Pane group to your template. In the Menu Pane's group
options set the following fields:
Reference
Set this option to Sections in menu.
Menu name
Enter the name of a menu you have created for this publication using the Content Engine's
Menu Editor plug-in.
You can now add groups, areas and widgets to the Menu Pane group to define the layout of the dropdown pane you want to be shown for the sections in menu. You can use all the same components that
you would use when creating a section page layout: Data Sources, Teaser widgets and so on. When the
user selects a section from the menu, then the selected section is supplied to these components as the
context section, and a pane layout is created.
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The drop down pane is only displayed for the sections in the menu: other elements such as articles
and links are simply rendered as links in the usual way.
Since sections in the displayed menu are rendered using the content of the Menu Pane, you cannot
use this technique to display multi-level menus: any subsections in the menu will be ignored.

7.14Use a Context Section Group
You can use a Context Section group to:
•

Display content from a specific section on the current page

•

Display content from multiple sections on the same page

•

Display content from a content item's owning section on a content page

When used to display content from multiple sections, the Context Section group works in a similar
way to the Menu Pane group, in that it relies on a menu created using the Menu Editor plug-in. The
Context Section group, however, does not use the menu as a menu, but just as a list of sections.
To use a Context Section group, you place it in the required location on the page and then set the
following options:
Use
Set this to either Specific section, Sections in menu (to display content from multiple
sections) or Home section of context article (for use on content pages).
Section
If you set Use to Specific section then select the section you want to use as the context section
Menu name
If you set Use to Sections in menu then enter the name of a menu you have created for this
publication using the Content Engine's Menu Editor plug-in.
You can now add groups, areas and widgets to the context section group to define the layout. If you set
Use to Sections in menu, then the layout you have defined will be repeated for every section in the
menu you specified. If you set Use to either Specific section or Home section of context article
then the layout will be used only once, to display the content from either the specified section or the
current content item's home section.
Lazy loading can be applied to Context Section groups, but only to the group as a whole, not to the
individual items (groups, areas and widgets) placed inside it.

7.15Enable Editorial Teaser Layout Control
The Widget Framework is in general designed to enforce a separation of concerns between editorial
staff and publication designers, so that editorial staff have very little control over the layout and
appearance of a publication. You can, however, provide editorial staff with some limited control over
the layout of section page teasers. You can do this for teasers that are displayed by Teaser Views under
the control of either View Picker or Teaser Grid widgets.
Enabling editorial control allows editorial staff to override the following aspects of teaser display:
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•

The Teaser view used

•

The font size used for the teaser's title and/or lead text

•

Whether or not an image is displayed with the teaser

•

The image aspect ratio

•

The CSS style used for the teaser

Editorial staff are able to change these display parameters by setting options on the section page
groups in which they desk the teaser content items (see chapter 8 for a description of these options).
For information about how to enable Editorial teaser layout control in Solr, see Editorial
Teaser Layout Control Configuration in the Escenic Widget Framework Developer Guide.

7.15.1 Editorial Control of View Picker Teasers
To enable editorial control over View Picker teasers you must:
1.

Create a View Picker widget and configure it to use a data source containing a "by section page
group" query that selects content items from a Curated view section page group.

2.

Ensure that the View Picker widget's Rendering mode option is set to Iterate with related
view.

3.

Ensure that the View Picker widget's Disable view adjustments by editor option is not
checked.

4.

Place the View Picker widget in the required location on the required section page template.

5.

If you want to allow editors to select Teaser views with the Use view option (see section 8.1.1),
then you need to ensure that Allow editors to select this view is set in the required Teaser
views.

7.15.2 Editorial Control of Teaser Grid Teasers
The Teaser Grid widget is explicitly designed to give editors control over teasers. To set up a Teaser
Grid widget for use:
1.

Create a Teaser Grid widget and configure it to use a data source containing a "by section page
group" query that selects content items from a Grid section page group.

2.

Place the Teaser Grid widget in the required location on the required section page template.

3.

Make sure that the Grid group referenced by the Teaser Grid widget's data source actually exists
(that is, either create it yourself or inform the editorial staff who control the relevant section page
that they need to create it).

4.

If you want to allow editors to select Teaser views with the Use view option (see section 8.2.1),
then you need to ensure that Allow editors to select this view is set in the required Teaser
views.

7.15.3 Defining Override CSS Styles
The Teaser Style option with which editorial staff can set CSS styles (see section 8.2.1) displays a
list of predefined options. The options displayed in this list can be modified and extended by adding a
configuration file to one of your installation's Content Engine configuration layers. Each style option
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is defined by two entries in the file, one to define the label displayed in the list of options and one to
specify the CSS classes that will be applied if it is selected:
options.curatedStyle.exclusive.value=well well-xs
options.curatedStyle.exclusive.label=Exclusive

Editing and deploying configuration layer properties files is more of a developer task than a
publication designer task, and the /com/escenic/framework/ui/Enumerations.properties
file that needs to be added is also used in the configuration of custom data sources, so this process is
described more fully in the Widget Framework Developer Guide, see field.

7.16Configure Video Advertising Services
The Widget Framework supports the inclusion of advertisements in video streams from on-line
advertising services that can supply ads in the following industry-standard formats:
•

VAST

•

Google IMA

Currently, you can only include ads in your videos if you use JW Player as your video player, and the
only kind of ads currently supported are pre-roll ads. Pre-roll ads are advertisements that play before
a requested video is played.
You can configure the inclusion of pre-roll advertisements in videos at three different levels:
•

At publication/section level, by setting the wf.media.ad.preroll.enable section parameter
on a section to true.

•

At widget level, by setting the Enable pre-roll option on the Advertisement tab of a Media
widget, Teaser widget or Teaser view

•

At content item level, setting the Enable pre-roll option on the Advertisement tab of a Video
content item

In all three cases you also have to supply a Service content item. A Service content item is designed
to hold the URL of an external service such as an advertising service. It has a field for holding a base
URL, plus an array of fields for holding parameter names and values, from which a complete URL
including a query string can be constructed. For a full description, see section 7.16.1. How you supply
the service content item varies as follows:
•

At publication/section level you specify the ID of the required Service content item by setting the
wf.media.ad.preroll.service.id section parameter. The ID of a content item is displayed
in the Content Info panel if you open it in Content Studio.

•

At widget and content item level you simply drop the required Service content item into the Preroll ad relation on the widget's or content item's Advertisement tab

You can configure pre-roll inclusion at several of the above level. If settings conflict, then the most
specific level wins: content item settings override widget settings and widget settings override section
settings.
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7.16.1 Defining a Service
A Service content item contains the following fields:
Title
The name of the service.
Service type
The type of service. Currently you can specify the following values:
VAST
Select this for ad services that supply ads in the VAST (Video Ad Serving Template)
format.
Google IMA
Select this for ad services that supply ads using (Google Interactive Media Ads) APIs.
Base URL
The base URL of the service (that is the URL without any parameters)
Parameters
An array of parameter settings for the service. Add the parameters required by the service you
are configuring. They are all assembled into a query string and appended to the Base URL to
create a complete service request.
Name
The name of a parameter required by the service you are configuring.
Value
The value to be assigned to this parameter. You can specify this value using a mixture of
literal text and JSTL expressions that will be replaced with dynamic values. Note that in
addition to the usual ${section} and ${article} objects, you also have access to the
following special context objects:
${sectionParams}
This object offers a shorthand means of accessing section parameters.
You can access a section parameter called x.y, for example, with
the expression ${sectionParams.x.y}. This is equivalent to
${section.parameters['x.y']}.
${mediaContent}
This object represents the video content item to be displayed.

Fallback
A fallback value to be assigned to this parameter if Value evaluates to an empty string.
Encode
Check this option if you want the value you have specified to be URL-encoded.
It also contains a Base Service relation on which you can drop another Service content item: the
current Service will then inherit the base Service's settings. Local settings override inherited settings.
This also applies to the contents of the Parameters array: a local parameter setting overrides an
inherited parameter with the same name.
This inheritance mechanism makes it easy to create a set of similar Services that all inherit from the
same base Service but have slightly different parameter settings.
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7.17Define a Media Player and Playlist
The Gallery template group is specially designed to support the display of a combined media player
and playlist on publication pages. The playlist offers a list of videos or other media items that can be
played in the media player. Selecting an item from the list causes it to start playing in the media player.
The media player and playlist are displayed together on the same page, and playing a media item does
not require the display of a new page or pop-up window.
In order to support this functionality, the Gallery group is allowed to contain a Data Source
component. (In general, Data Source components are not allowed in templates, so this is a special
case.) The way it works is this:
•

The Gallery group has a Data Source area, into which you can drop a Data Source component (the
same way you add widgets to a template).

•

The Data Source component is set up with queries to select the media items you want to appear in
the playlist.

•

The Gallery group also has a View area, to which you can add a Media widget and some Teaser and/
or View Picker widgets. You need to include at least one Teaser/View Picker widget to display the
playlist. You will often, however, want to include at least one more Teaser/View Picker widget in
order to provide a summary for the currently selected media item, as in the example shown below.

•

Both the playlist and the summary widgets must be set up to get their content from the Gallery's
Data Source.

•

The playlist and summary widgets can then be configured in the usual way to provide the required
views of the content items provided by the Data Source.

Here is an example of a media player, summary and playlist displayed in a publication:
Media player

Playlist view

Sum m ary view
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Here is the template group structure required to produce the above combination:

The specific settings required to achieve this kind of result are:
•

The Data Source must be configured in the usual way to return a sequence of media items suitable
for playback by the media player.

•

The Data Source must be dropped in the Gallery's Data Source area. You can use this area's options
(see Data Source Options) to limit how many (and which) of the Data Source's media items are
actually made available to the Gallery's widgets. You could for example, set the Data Source area
Maximum items options to 6. Only a maximum of 6 items will then be displayed in the playlist,
even if the Data Source returns many more.

•

The Media and Teaser widgets can be arranged on the page using Column and Row groups in any
way you like.

•

You can use either Teaser widgets or View Picker widgets + Teaser Views for the playlist and
summary views. Teasers are the simplest option, while a View Picker plus Teaser Views offers more
flexibility (see section 4.4.5 for details).

•

Whichever widget type you use, both the playlist and the summary widget must be configured
to use the Gallery's data source. You do this by setting the Use option (on the Teaser and View
Picker's Data Source tab) to Template Data Source.

•

Both the Link settings / Link behaviour option and the Media settings / Media play mode
option on the playlist widget's Advanced tab must be set to Select from gallery.

•

You will also need to add a CSS class name to your summary view widget's Widget wrapper
settings / Style Class field (on the Advanced tab), which should be supplied to you by a
template developer. If you want to know more about this, see Control Content Visibility in a Gallery
Group in the Developer Guide.

•

Otherwise, the playlist and summary view widgets can be configured in the usual way to include
whatever elements you require.

7.17.1 Media Player/Playlist for In-line Content
You can display a media player/playlist combination for in-line media content by making use of a
Master view. A Master view is like a Master widget – it displays a set of widgets defined in a master
template. However, unlike a Master widget, it cannot be placed directly in a template. Instead, it must
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be used in combination with a Content Body widget. It can then render content delegated to it by the
parent widget.
The Master view was introduced specifically to support the display of media player/playlist
combinations for in-line media, and can be used as follows:
1.

Open the content template to which you wish to add support for in-line media playlists.

2.

Create a master template (see section 3.6) containing a media player/playlist template group
structure as described in section 7.17.

3.

Open the content template's Content Body widget (or create one and add it if necessary). This
widget renders content items' Body fields.

4.

Make sure that the Content Body widget's Inline content option is set to true – otherwise any
in-line content will be skipped.

5.

Create a Master view and set its Master section field to point to the master template you have
created.

6.

Drop the Master view you have created on to your Content Body widget's Related view relation.

7.

Edit the Master view's Owner Widget Settings fields to indicate what types of content items it
is intended to handle. To display all in-line videos using this Master view, for example, you would
set Select by to Content type and add Video to the Content type name field.

With this configuration, every time the Content Body encounters an in-line item in the body field, it
will not attempt to render it itself, but instead pass it on (that is, delegate rendering) to one of the
views in its Related view relation. It determines which view to delegate the item to by examining the
views' Owner Widget Settings and choosing the most appropriate view.
During the rendering process, the delegated video is the context content item, and its home section
is the context section. Typically, you would want to have configured the data source in the master
template with a query that makes use of these context items to return related videos for display in the
playlist. You might, for example, have configured the data source to use Query by shared tag. This
would result in a playlist containing videos that are tagged with the same tags as the delegated in-line
video.

7.18Use Person Profiles
The Widget Framework includes a Profile content type that can be used to hold additional personal
information about users and persons registered in the Content Engine database. Profiles are typically
used to hold an image (for use in bylines) and biographical details. Profile content items can be directly
related to the Persons/Users they describe, and the Widget Framework includes functionality that
uses this relationship, enabling information about the author of a content item (a byline photo, for
example) to be easily included in templates.

7.18.1 Creating a Profile Template
In order to make use of profiles in a publication you need to create a template for profile
pages. Create the template as a child of the article template, and give it the unique name
config.default.article.type.profile. The template can be used in exactly the same way
as any other content template - you can add Content Information widgets, for example, to place the
content of various Profile fields on the page.
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You cannot use the Author's photo option described in section 7.18.2 to include a profile photo
in the profile page itself - if you do so, you will get a photo of the profile's author instead of the
profile's subject. Instead, you will need to retrieve the image with a "Query by relation" Data Source
and use either a Teaser widget or a Teaser View and View Picker widget to display the image.

7.18.2 Including Profile Images in Page Templates
When creating content templates, you often want to include a byline photo of the content item's
author. Assuming you have created profiles of your authors and that they contain photos, you can
include a byline photo by using any of the following three widgets:
Content Information widget
Select Author's photo from this widget's Content Info drop-down.
Teaser View widget
Select Author's photo from one of this widget's Elements drop-downs.
Teaser widget
Select Author's photo from one of this widget's Elements drop-downs.

7.18.3 Creating a Profile
A Profile is created in the same way as any other content item, using the supplied Profile content type.
If you want to include a photo in a profile, you can do so by dropping the Picture item containing the
photo onto the Profile's Lead relation drop zone.
Once you have created the Profile, you need to associate it with the person it describes. To do this:
1.

Find and open the relevant Person content item.

2.

Drop the Profile on the Person content item's Profiles relation drop zone.

7.19Set up Video Watermarking
A watermark is an image (such as a company logo) that is burned into a video stream, often used for
branding or to indicate copyright ownership. The Widget Framework supports automated addition of
watermarks to videos, but watermarking depends on setup of Amazon Elastic Transcoder as well the
Widget Framework. Much of this process is covered in the Video Plug-in Guide.
Once Watermarking has been set up, it is very easy for editorial staff to use. The Widget Framework
allows videos to be stamped with multiple watermarks in different positions if required. Exactly what
watermarks are to be used can be set using section parameters. This means that you can, for example,
configure the watermarks to be used on all the videos in a publication by setting watermark section
parameters in the root section, and then override those settings locally by resetting the parameters in
specific sections. In addition, the Video content type has a Disable Watermarking option that lets
editorial staff turn off watermarking for individual videos if required.
The following description assumes that Amazon Elastic Transcoder has been set up to use the
watermark IDs TopLeft, TopRight, BottomLeft and BottomRight as recommended in the
Video Plug-in Guide.
To set up watermarking, you need to:
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Find your watermark images
Find the images you want to use as watermarks. The images must be PNG or JPG files, and in
addition, they must have one of the following extensions:
.jpg
.jpeg
.png
You must rename any images that have different extensions (for example .JPG). This
requirement is due to a limitation in Amazon Elastic Transcoder.
Upload watermark images to the Content Engine
Upload the images in the usual way using Content Studio. However, do not upload them as
Pictures, but as Watermark content items. For each image you want to upload, create a new
Watermark content item and then select the image to upload. Make a note of each Watermark's
content item ID, as you will need it when setting the section parameters in your publications.
Add watermark section parameters to your publications
You need to configure section parameters in every publication that is to use watermarking. To
set up watermarking for a whole publication, add the parameters to the root section. To set
up watermarking only in specific sections, or to override the publication level settings, add
parameters to the specific sections.
For a detailed description of how to set the watermarking section parameters, see this section of
the Video Plug-in Guide.

7.20Display Live Blog Entries
If your installation includes Live Center (a Content Engine plug-in for editing and managing
live blogs) then you can use the Widget Framework's Live Entries view to create layouts for the
blog entries. The Live Entries component is a view, not a widget: that is, it has no "back-end" for
retrieving content items from the Content Engine and therefore cannot be used on its own in a section
template.
You can use a Live Entries view in two ways:
•

In a section template as part of a Teaser widget or Teaser view

•

In a content template used to display Event content items

7.20.1 Live Blog Entries in a Section Template
To display live blog entries on section pages:
1.

Open or create the section template you want to use for live blogs.

2.

Create a Teaser widget and configure it with a query that retrieves Event content items.

3.

Configure the Teaser widget to display the general fields of the Event (Title, Description and so
on).

4.

Create a Live Entries view and configure it to display event entries as required. The basic process
of configuring a Live Entries view is similar to configuring a Teaser widget or view: you select
which entry fields you want to include, and specify how they are to be formatted. You can also
configure the number of entries to be initially displayed. For the details of how to configure a Live
Entries view, see Live Entries view.
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5.

Drag the Live Entries view into the Teaser widget's Related live entries view drop zone (on its
Default tab)

6.

Drop the Teaser widget in the required position on the section template.

7.

Publish all the components you have edited: the Live Entries view, the Teaser widget and the
section template.
You can replace the Teaser widget in the above procedure with a Teaser view. In this case, however,
a fourth component is required, since a Teaser view, like a Live Entries has no back end for
retrieving content items. The Teaser view must itself be dropped in the Related view field of
another widget, and it is this owning widget that is placed in the section template. For details, see
Teaser view.

7.20.2 Live Blog Entries in a Content Template
To display live blog entries on content pages:
1.

Open or create the content template you want to use for live blogs.

2.

If necessary, create and configure the widgets you need to display the required parts of your
Event content item (for example, a Content Field widget, a Content Information widget and a
Content Body widget). You may not need to do this, because you have already created suitable
widgets for use in other content templates, in which case you can re-use them.

3.

Drop the widgets in the required positions on the content template.

4.

Create a Live Entries view and configure it to display event entries as required. The basic process
of configuring a Live Entries view is similar to configuring a Teaser widget or view: you select
which entry fields you want to include, and specify how they are to be formatted. You can also
configure the number of entries to be initially displayed. For the details of how to configure a Live
Entries view, see Live Entries view.

5.

Drop the Live Entries view in the required position on the content template.

6.

Publish all the components you have edited: the Live Entries view, any widgets you have created
or modified and the content template.

7.20.3 Embedded Content Items
To display Escenic content items that have been embedded in live blog entries:
1.

Open or create the OEmbed template you want to use for embedded content items. See section
3.2.1.2 for further information.

2.

If necessary, create and configure the widgets you need to display the required parts of your
embedded content item (for example, a Teaser widget, a Media widget, a Content Field widget, a
Content Information widget and a Content Body widget). You may not need to do this, because
you have already created suitable widgets for use in other content templates, in which case you
can re-use them.

3.

Drop the widgets in the required positions on the OEmbed template.

4.

Publish all the components you have edited: the OEmbed template and any widgets you have
created or modified.
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8 Editorial Layout Control
The Widget Framework is in general designed to enforce a separation of concerns between editorial
staff and publication designers: editorial staff are responsible for content and organisation: designers
are responsible for layout and functionality. For some organizations, however, this separation can be
too strict, and there is a requirement to provide editorial staff some control over layout. This chapter
describes the layout controls the Widget Framework can make available to editorial staff.
The functionality described here is available to editors when editing section pages. It mostly needs to
be enabled by designers, however, and is only useful if designers have configured other components to
make use of it.

8.1 Using Curated View Groups
Curated View is a top-level group type that you can add to section pages by right-clicking on the
Content Area root and selecting Insert > Insert new Curated view. You can then drag content
items into the group in the usual way. What is special about the Curated view group is that you can
then control the appearance of the teasers generated for these content items by setting various display
options (see section 8.1.1).
There no point adding a Curated view group to a section page unless you know that your designers
have configured a View Picker widget to display the content items that you add to it. Your usage of
Curated view groups must be co-ordinated with the designers.

8.1.1

Curated View Options

If you select a Curated View group in a section page editor, then the following options are displayed
on the right:
Use view
Use this option to select the Teaser view that will be used for all teasers in the group. Start
typing and then select the required teaser view from the displayed options. The view you select is
used to override the default Teaser view(s) configured by the publication designer.
Image
Use this option to select the image version to be used for any images in the teasers in the group.
You can also suppress the display of images by selecting the Hide option.
Teaser style
Select a style to be applied to all teasers in the group.
Title size
Select a font size to be applied to the titles of all teasers in the group.
Lead text size
Select a font size to be applied to the lead text of all teasers in the group.
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8.2 Using Grid Groups
Grid is a top-level group type that you can add to section pages by right-clicking on the Content
Area root and selecting Insert > Insert new Grid. Most of the groups that you can add to section
pages in a standard Widget Framework publication are simple groups that cannot be subdivided.
Grid groups, however, have a standard set of subgroups representing various column arrangements.
You can use them to control how teasers are to be laid out on a page or part of a page. First you
subdivide the Grid group by inserting one or more subgroups, and then you drag content items into the
subgroups, not the the root Grid.
There no point adding a Grid group to a section page unless you know that your designers have
configured a Teaser Grid widget to display the content items that you add to it. Your usage of Grid
groups must be co-ordinated with the designers.
You can insert the following subgroups into a Grid group by right-clicking on the group, then selecting
Insert > Insert new [group]:
Row
A container for Column groups. You can add as many Rows as you like to a Grid. Do not add
content items directly to a Row. A number of options are displayed on the right, which you can
use to override default teaser formats (see section 8.2.1).
Column
Insert into a Row group. You can add as many Columns as you like to a Row. You can then either
fill the columns with content items as required or subdivide it further. A Column group has a
Width option that you can use to control column width. The total width of all the Columns in a
Row should not exceed 12.
Two column
A predefined row containing two columns. Any content items you add to a Two column group
are divided between the two columns: the first half are put in column 1, and the second half
in column 2. If you add an odd number of content items, then column 1 will get the extra one.
A number of options are displayed on the right, which you can use to override default teaser
formats and control column widths (see section 8.2.1).
Three column
A predefined row containing three columns. Any content items you add to a Three column group
are divided between the three columns: the first third are put in column 1, the second third in
column 2 and the remainder in column 3. A number of options are displayed on the right, which
you can use to override default teaser formats and control column widths (see section 8.2.1).
Two column (1+N)
A predefined row containing two columns. It works the same way as the Two column group
except that only the first content item is allocated to the first column, and all the remaining
content items are allocated to the second column. A number of options are displayed on the
right, which you can use to override default teaser formats and control column widths (see
section 8.2.1).
Two column (N+1)
A predefined row containing two columns. It works the same way as the Two column group
except that only the last content item is allocated to the first column, and all the remaining
content items are allocated to the second column. A number of options are displayed on the
right, which you can use to override default teaser formats and control column widths (see
section 8.2.1).
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8.2.1

Grid Options

If you select a Row, Two column, Three column, Two column (1+N) or Two column (N+1)
group in a section page editor, then the following options are displayed on the right:
Use view
Use this option to select the Teaser view that will be used for all teasers in the group. Start
typing and then select the required teaser view from the displayed options. The view you select is
used to override the default Teaser view(s) configured by the publication designer.
Image
Use this option to select the image version to be used for any images in the teasers in the group.
You can also suppress the display of images by selecting the Hide option.
Teaser style
Select a style to be applied to all teasers in the group.
Title size
Select a font size to be applied to the titles of all teasers in the group.
Lead text size
Select a font size to be applied to the lead text of all teasers in the group.
1st column size
Select the width to be used for the first column in a two or three column group. Remember that
the total width available for all columns across the total page width is 12.
2nd column size
Select the width to be used for the second column in a three column group. Remember that the
total width available for all columns across the total page width is 12.
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